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ガイドの見方
本クイックスタートガイドで使用する記号とその内容について説明します。

記号 内容 例

知っておく必要のある内容を記載
しています。

C言語コントローラユニットのプログラムの演算は，ス
イッチの状態が RUN/STOP にかかわらず実行されます。

参照マニュアルや詳細を記載して
いるページを紹介しています。

下記マニュアルを参照してください。

C言語コントローラユニットユーザーズマ
ニュアル ( ハードウェア設計・機能解説編 )
：SH-080764

用語の説明を記載しています。
バッファメモリ：インテリジェント機能ユニット内部の

記憶領域で，C言語コントローラユ
ニットと受け渡しするデータ ( 設定値，
モニタ値など ) が格納されます。

作業を行う上で必ず注意すること
を記載しています。

ユニットを取り付けるときは，必ず電源を遮断してくだ
さい。

[ ]
メニューバーのメニュー名
([ ] → [ ] はドロップダウンメ
ニューを示します。)

メニュー [Project] → [Properties]

画面のボタン ボタン

キーボードのキー キー

Point

参考

用語

F4
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はじめに
本クイックスタートガイドは，三菱電機シーケンサMELSEC-Q シリーズ C言語コントローラユニット
( 以下 C言語コントローラユニット ) を初めて使用する場合の基本的な導入手順を，わかりやすく説明
しています。
MELSEC-Q シリーズを初めて使用する方で，下記のような方が，C言語コントローラユニットの使い
方を簡単に理解することができるようになっています。
　　・C言語または C++言語プログラムのプログラミング経験がある
　　・マイコンボードやパソコン環境から C言語コントローラユニットを使ったシステムへの置換え
　　　を考えている

参考

●使用上の注意事項
C言語コントローラユニットを安全に使用するために，C言語コントローラユニットユーザー
ズマニュアルの「安全上のご注意」をよく読んだ上で，使用してください。

本クイックスタートガイドは，「〈2〉システムを構築する」(P.13) に示すシステム構成での操
作を前提としています。
実際にシステムを設計／運用する場合には，下記ページで紹介しているマニュアルを必ずお
読みください。

「関連マニュアル」(P.10)

ユニットの装着や配線

動作確認

プログラムの作成

クイックスタート
ガイド

/* バスをオープンする　　　　　 */
sRet = QBF_Open( CPU_TYPE, &lPath );
if( sRet != n ){
       :
/* 出力制御，7セグメントLED制御 */
for( i = 0; i < 20; i++ ){
    /* 出力制御　　　　　　　　 */
    sRet = QBF_Y_Out_WordEx( lPath, 
       :

AC100V DC24V
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C言語コントローラユニットでできること

■ 複雑かつ高速な処理や上位サーバとの通信処理ができます
C言語コントローラユニットは，C言語または C++ 言語プログラムを使ってMELSEC-Q シリーズのユ
ニットの管理や入出力機器の制御を行う CPU ユニットで，下記のようなことが可能です。
　・マイコンボードやパソコン環境で開発した C言語または C++言語プログラムの流用
　・ラダープログラムでは困難な，複雑かつ高速な情報・演算処理が必要な分野での活用 ( 半導体製
造，FPD製造，太陽電池製造，公共インフラ ( 電気，ガス，水道など ) 遠隔監視など )

C 言語コントローラユニットは，ユーザプログラムによって，さまざまな機能を簡単に実現できます。
また，パートナ製品を活用することで，例えば下記のような機能も簡単に実行できます。
　・SECS 通信ソフトウェアパッケージにより，半導体製造分野などでよく使われる SECS 通信にプロ
グラムレスで対応し，上位サーバとの通信もゲートウェイパソコンなしで直接実行

　・ビジョンシステムと連携し，画像識別や製品検査などをパソコンレスで実行

■ 豊富な機能を実装し，リアルタイムな制御を実現します
C言語コントローラユニットは，実績と信頼性のあるリアルタイムOS，VxWorks( 米国ウインドリ
バー・システムズ社製 ) を標準搭載しています。( ランタイムライセンス費用は発生しません。)
VxWorks は，プリエンティブ方式*1 によって，リアルタイムな演算処理が可能です。
そのため，パソコン環境とは異なり，割込みや定時性が求められる処理などにも確実に対応できます。
また，VxWorks は，ファイルアクセスやネットワーク機能のドライバ，入出力や通信のライブラリな
ど，豊富な機能を標準で実装しているため，さまざまな用途に即応できます。
＊ 1 複数のプログラムを実行する上で，特定のプログラムだけがプロセッサ (CPU) を専有することなく，公平に実行時間を割

り振ることができる処理方式。

●半導体製造
●FPD製造 ラダーでは

難しい
高速な情報
・演算処理が
可能

SECS通信
ゲートウェイ
にもなり
コスト・

サイズダウン

C言語
プログラム

資産が流用でき
開発コストを
削減

フィールド
ネットワークや

センサネットワークなどで
高速なデータ収集を
省配線で簡単に実現

演算・制御

SECS通信(Ethernet)

上位サーバ

データ収集

●FPD画像検査
ビジョン連携による画像識別

ツール設定のみで可能

サーボ
アンプとの

高速同期通信も
利用可能

装置内のコントローラ間通信

PULL

POWER

Q61P-A1

QJ71C24 QJ71C24

QD70
QX10

QJ71LP21-25

Q06CCPU
MODE

ERR.

USER.

CH1 10BASE-T/100BASE-TX

RUN
CF CARD

CF CARD

CH2
RS-232

CH2 SD/RD

Q12DCCPU-V
MODE

ERR.

USER.

RUN
CF CARD

CF CARD

CH2 SD/RDマシン
ビジョン

Ethernet

省スペースで
耐環境性も
安心

最大1Gbpsの
高速・大容量な
コントローラ
ネットワークで
タクトタイム短縮！

画像識別・
製品検査などを
パソコンレスで
実現！

PULL

POWER

Q61P-A1

QJ71C24 QJ71C24

QD70
QX10

QJ71LP21-25

Q06CCPU
MODE

ERR.

USER.

CH1 10BASE-T/100BASE-TX

RUN
CF CARD

CF CARD

CH2
RS-232

CH2 SD/RD

Q12DCCPU-V
MODE

ERR.

USER.

RUN
CF CARD

CF CARD

CH2 SD/RD

PULL

POWER

Q61P-A1

QJ71C24 QJ71C24

QD70
QX10

QJ71LP21-25

Q06CCPU
MODE

ERR.

USER.

CH1 10BASE-T/100BASE-TX

RUN
CF CARD

CF CARD

CH2
RS-232

CH2 SD/RD

Q12DCCPU-V
MODE

ERR.

USER.

RUN
CF CARD

CF CARD

CH2 SD/RD
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■ C 言語コントローラユニットの特長

1. MELSEC-Q シリーズの豊富なユニットで柔軟にシステム構築！
C 言語コントローラシステムでは，プログラム資産を流用できるだけではなく，MELSEC-Q シリーズ
の豊富なユニットを活用でき，システム構成の変更も簡単です。

2. OS，ドライバ，ライブラリを実装済みで，ユーザプログラム開発に専念！
C 言語コントローラユニットには，OSと通信ドライバが組み込まれています。マイコンボードやパソ
コン環境での面倒な作業 (OS 移植，ドライバ開発，ROMへの OS書込みなど ) が不要なため，ユーザ
プログラムの開発に専念することができます。
また，MELSEC-Q シリーズの各ユニットには，C言語コントローラユニットの専用ライブラリ関数 ( バ
スインタフェース関数，MELSEC 通信関数 ) により，簡単にアクセスできます。

ボードは
　大変だ～

マイコンボードやパソコン環境 C言語コントローラシステム

電源ユニット

入出力
ユニット
高速入力,
割込み入力，
AC/DC…
45機種以上

　高信頼
・

長期安定
供給

ボード／チップの　　生産中止

製品のライフサイクルが短い

MELSEC-Qシリーズの豊富なユニットで
柔軟にシステム構築

簡単に
スロット
イン

ハードウ
ェアの仕

様や環境

による制
約で拡張

しづらい

ハードウ
ェアの

選択肢が
少ない

システムの変更時は着脱も面倒

ベースユ
ニットも

増設でき
，拡張も

簡単

アナログ
ユニット
A/D変換，
D/A変換，
温度調節…
27機種以上

ネットワーク
ユニット
コントローラ間,
省配線,
センサ…
17機種以上

位置決め
ユニット
4軸,8軸,16軸,
パルス入力,
差動出力…
26機種以上

Q173DCPU Q173DCPU Q173DCPU

情報
ユニット など
ロギング，
MES通信,
シリアル通信…
5機種以上

マイコンボードやパソコン環境

専用ライ
ブラリ

関数で簡
単！

各ユニットへのアクセスも…

アナログ
ドライバ

I/O
ドラ
イバ

ネットワーク
ドライバ

ネットワーク
ボード

I/O
ボー
ド

アナログ
ボード

PULL

POWER

Q61P-A1

QJ71C24 QJ71C24

QD70
QX10

QJ71LP21-25

Q06CCPU
MODE

ERR.

USER.

CH1 10BASE-T/100BASE-TX

RUN
CF CARD

CF CARD

CH2
RS-232

CH2 SD/RD

Q12DCCPU-V
MODE

ERR.

USER.

RUN
CF CARD

CF CARD

CH2 SD/RD

C言語コントローラシステム

ユーザ
プログラム

ライブ
ラリ

ライブ
ラリ ライブラリ

OS(システム構成
によって変更)

ユーザ
プログラム

作成はユ
ーザ

プログラ
ムのみ！

アナログ
ドライバ

I/O
ドラ
イバ

ネットワーク
ドライバ

ライブ
ラリ

ライブ
ラリ ライブラリ

OS(VxWorks)

実装
済み

簡単！
早期立上げ！

OS作成，
ボードご

とにドラ

イバとラ
イブラリ

を作成…

システムが変わったらまた作り直し…

工数大！
面倒！
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3. 初期化やパラメータ設定，モニタ・テストが，プログラムレスで可能！
C 言語コントローラユニットの初期化，システム設定，ネットワークユニットのパラメータ設定など
のために，複雑なプログラムを組む必要はありません。C言語コントローラユニット用ユニット設定・
モニタツールのビジュアルな画面を操作するだけで，簡単に作業が完了します。
また，各ユニットの状態，C言語コントローラユニットやユーザプログラムで発生したエラーなどの
確認，ケーブル断線や通信状態などの確認も，プログラムレスで可能です。

4. 手軽な統合開発環境「CW Workbench」でクイックスタート !
プログラムの編集から実行モジュールの生成，デバッグまでの基本機能を備えた C言語コントローラ
用エンジニアリングツール「CW Workbench」により，手軽に C言語コントローラユニットのユーザ
プログラムを開発できます。
また，Eclipse ベースの CW Workbench は，サードパーティ製のプラグインソフトにより機能拡張が
可能です。

int nRet;                   // 関数
DWORD nLen;                 // バッ
ULONG ulBoardNo = 0;        // ボー

// ボード番号0 のボードを初期化
nRet = GpibOpen( ulBoardNo );
if (nRet) {
    printf("ボード番号0のボードが初
    printf("エラーコード : %d\n", n

int nRet;                                     // 関数
DWORD nLen;                         // バッ
ULONG ulBoardNo = 0;        // ボー

// ボード番号0 のボードを初期化
nRet = GpibOpen( ulBoardNo );
if (nRet) {
    printf("ボード番号0のボードが初
    printf("エラーコード : %d\n", n

/* Md.31 ステータス情報            
printf("Status        [Md.31 ]");
printf("%7s0x%04hX%8s0x%04hX%8s0x%0

/*  QD75MまたはQD75MHを指定している
if( (sType == UNITTYPE_QD75M) || (s
    /* Md.108 サーボステータス情報 
    printf("ServoStatus   [Md.108]"
    printf("%7s0x%04hX%8s0x%04hX%8s

マイコンボードやパソコン環境 C言語コントローラシステム

またイチから
　プログラム
　　やり直し? Ethernet

/* Md.31 ステータス情報            
printf("Status        [Md.31 ]");
printf("%7s0x%04hX%8s0x%04hX%8s0x%0

/*  QD75MまたはQD75MHを指定している
if( (sType == UNITTYPE_QD75M) || (s
    /* Md.108 サーボステータス情報 
    printf("ServoStatus   [Md.108]"
    printf("%7s0x%04hX%8s0x%04hX%8s

モニタ

C言語コントローラユニット用
ユニット設定・モニタツール

モニタ
テスト

診断・
エラー履歴

ビジュアルな画面でモニタや設定などが可能

/* バスをオープンする　　　　　 */
sRet = QBF_Open( CPU_TYPE, &lPath );
if( sRet != n ){
       :
/* 出力制御，7セグメントLED制御 */
for( i = 0; i < 20; i++ ){
    /* 出力制御　　　　　　　　 */
    sRet = QBF_Y_Out_WordEx( lPath, 
       :

パラメータ設定
/* バスをオープンする　　　　　 */
sRet = QBF_Open( CPU_TYPE, &lPath );
if( sRet != n ){
       :
/* 出力制御，7セグメントLED制御 */
for( i = 0; i < 20; i++ ){
    /* 出力制御　　　　　　　　 */
    sRet = QBF_Y_Out_WordEx( lPath, 
       :

モニタ
/* バスをオープンする　　　　　 */
sRet = QBF_Open( CPU_TYPE, &lPath );
if( sRet != n ){
       :
/* 出力制御，7セグメントLED制御 */
for( i = 0; i < 20; i++ ){
    /* 出力制御　　　　　　　　 */
    sRet = QBF_Y_Out_WordEx( lPath, 
       :

初期化
オール
イン
ワンコンパイル

プログラム作成／修正

ダウンロード

デバッグ

ミスや
変更があると
やり直し

初期化

すべて
プログラムが
必要

手順も
面倒

パラメータ
設定

PULL

POWER

Q61P-A1

QJ71C24 QJ71C24

QD70
QX10

QJ71LP21-25

Q06CCPU
MODE

ERR.

USER.

CH1 10BASE-T/100BASE-TX

RUN
CF CARD

CF CARD

CH2
RS-232

CH2 SD/RD

Q12DCCPU-V
MODE

ERR.

USER.

RUN
CF CARD

CF CARD

CH2 SD/RD

ulSize      = (unsigned long)(PARAM
ulBufSize   = 0;                   
sRet=QBF_ToBuf( lPath, usIoNo / 16,
                ulSize, (unsigned s
                ulBufSize);

/*  書き込み判別処理               
if(sRet != 0){
    printf("Parameter area write er

ulSize      = (unsigned long)(PARAM
ulBufSize   = 0;                   
sRet=QBF_ToBuf( lPath, usIoNo / 16,
                ulSize, (unsigned s
                ulBufSize);

/*  書き込み判別処理               
if(sRet != 0){
    printf("Parameter area write er

パラメータ設定

プラグインにより,
メニュー項目などの多言語化や

ソースコード管理
なども可能！

Ethernet

POWER

Q172LX Q172EX Q173PX QX40 QD70P8

PULL

0
1
2
3
4
5
6
7
8
9
A
B
C
D
E
F

MODE

Q26UDHCPU

RUN
ERR
USER
BAT

BOOT

USB

PULL

Q12DCCPU-V

RUN
CF CARD

CH2 SD/RD

MODE
ERR.
USER.

PULL

USB

CW Workbench

“Project Explorer”ウィンドウ

“Editor”ウィンドウ

“Remote Systems”ウィンドウ

“Breakpoints”ウィンドウ

“Debug”ウィンドウ

“Build Console”ウィンドウ

“Expressions”ウィンドウ

“Memory Browse”ウィンドウ

“Variables”ウィンドウ

“Registers”ウィンドウ

プロジェクトの管理，設定

C言語コントローラユニットへの接続操作

ビルド処理過程の表示

ローカル変数の現在値の表示

レジスタの現在値の表示 C言語コントローラユニット上のメモリダンプの表示

ウォッチ登録した変数の現在値の表示

パソコン

ブレイクポイント管理

デバッグ操作
プログラム編集
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5. 高速バス通信で連携するマルチCPUシステムにより，高速・高精度な制御を
実現！
CPU間高速バス通信により，モーション CPUの演算周期 0.88ms に同期したリアルタイムな逐次制御
や時々刻々と目標値が変化する追従制御などに対応できます。
プログラムレスで最大 14K ワードの大容量データを 0.88ms 周期で高速転送することができ，CPU間
同士でデータを共有することができます。
また，マルチ CPU システムによって工場内の制御の中枢となる CPU を統合すれば，システム全体を
効率的に制御することができ，負荷が分散されます。

・シーケンサCPU

ラダー
プログラム

共有メモリ

大容量
データ

高速転送

・C言語CPU
　(C言語コントローラユニット)

C言語
プログラム

専用ライブラリ関数

共有メモリ

大容量
データ

高速転送

・モーションCPU

モーション
プログラム

共有メモリ

ダイレクト
指令

ダイレクト
指令

POWER

Q172LX Q172EX Q173PX QX40 QD70P8

PULL

0
1
2
3
4
5
6
7
8
9
A
B
C
D
E
F

MODE

Q26UDHCPU

RUN
ERR

USER
BAT
BOOT

USB

PULL

Q12DCCPU-V

RUN
CF CARD
CH2 SD/RD

MODE
ERR.
USER.

PULL

USB

Ethernet 各コントローラを
統合！

マルチCPU
システム

入出力
制御

情報
制御

サーボ
制御

0.88ms
サイクリック

マルチCPUを意識させない共有メモリ方式
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6. パートナ製品の活用により用途拡大！
C 言語コントローラユニットに下記などのパートナ製品を組み合わせれば，さらに高機能で使いやす
い情報連携を行うことができます。

　(1) SECS 通信ソフトウェアパッケージとの情報連携
SECS/GEM通信ソフトウェアを導入すれば，パソコンレス，プログラムレスで上位サーバとの
SECS 通信 (GEM*1 ／非 GEM) を実現でき，製造装置の状態管理や情報収集が可能になります。

          ＊ 1　半導体の製造ラインで使用される，業界標準通信プロトコルの 1つ。

　(2) ビジョンシステム (COGNEX In-Sight EZ, In-Sight Micro, In-Sight5000 シリーズ ) との連携
COGNEX マシンビジョンと C言語コントローラユニットの連携により，製品の測定，検査，識
別など製造工程の自動化を簡単に実現できます。

PULL

POWER

Q61P-A1

QJ71C24 QJ71C24

QD70
QX10

QJ71LP21-25

Q06CCPU
MODE

ERR.

USER.

CH1 10BASE-T/100BASE-TX

RUN
CF CARD

CF CARD

CH2
RS-232

CH2 SD/RD

Q12DCCPU-V
MODE

ERR.

USER.

RUN
CF CARD

CF CARD

CH2 SD/RD

マイコンボードやパソコン環境 C言語コントローラシステム

上位
サーバ

パソコン
が必要

パソコン運用負荷

ハングアッ
プ

故障

開発コスト
増大

膨大な通信プログラム

パソコン設置スペース要

パソコン
レス

SECS通信

ゲートウェイ
パソコンに，
SECS通信を行う
プログラムが必要

製造
装置

製造
装置

上位
サーバ

コンパクトフラッシュカードに
SECS/GEM通信ソフトウェアをインストール

C言語コントローラユニット
にSECS/GEM通信ソフトウェ
ア実行モジュールを実装する
だけで直接SECS通信が可能！

ツール設定のみでGEM定義
が可能！
GEM規格以外でも独自フレ
ームを定義して通信可能！

C言語コントローラユニット
をSECS通信ゲートウェイとす
ることで，コスト削減＆省ス
ペース！

SECS通信は
コストや手間が大変

パソコンレスを実現

プログラムレスの
簡単設定

コストダウン・
サイズダウン

HUB

In-Sight
EZシリーズ

In-Sight
Microシリーズ

C言語プログラムによるコマンド送信により，
撮像や画像の取込み処理の実行が可能！

通信ケーブルと電源ケーブルを一体化した
省配線システムを実現！

画像処理プロセッサ一体型の
マシンビジョンと連携！

Ethernet
接続可能
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関連マニュアル
本クイックスタートガイドでは，C言語コントローラユニットの基本的な導入手順を紹介しています。
C言語コントローラユニットを十分に活用するために，目的に応じて，下記のマニュアルをお読みく
ださい。

■ C 言語コントローラユニットについて詳しく知りたいとき

■ CW Workbench について詳しく知りたいとき

マニュアルの PDF を，下記からダウンロードできます。
三菱電機 FAサイトホームページ
(www.MitsubishiElectric.co.jp/fa)

●MELSEC-Q C 言語コントローラユニットユーザーズマニュアル
 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . SH-081077

C 言語コントローラユニットのシステム構成，仕様，機能，取扱い，配線，トラブル
シューティング，および関数とプログラミングについて説明しています。

●C言語コントローラ設定・モニタツール Version 4 オペレーティングマニュアル
 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . SH-081076

C 言語コントローラ設定・モニタツールのシステム構成，操作方法について説明しています。

●CW Workbench オペレーティングマニュアル . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . SH-080981
CW Workbench のシステム構成，インストール／アンインストール，仕様，機能，トラブ
ルシューティングについて記載しています。
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C言語コントローラユニットを使ってみよう
C 言語コントローラユニットは次のような手順で導入します。

〈1〉作業を行う前に (P.12)
　　　必要な機材を準備します。

〈2〉システムを構築する (P.13)
　　　準備した機材を設置して配線し，電源を入れます。

　　　1) システム構成例 (P.13)
　　　　　　本クイックスタートガイドの操作説明で使用するシステム構成例です。
　　　2) ユニットを装着する (P.14)
　　　　　　システムを構成するユニットを，ベースユニットに装着します。
　　　3) ユニットの配線を行う (P.15)
　　　　　　電源ユニットおよび出力ユニットへの配線をします。
　　　4) 電源が正常か確認する (P.17)
　　　　　　システムの電源を入れて，ユニットの状態を確認します。

〈3〉ユニットの設定をする (P.19)
　　　C言語コントローラ設定・モニタツールを使って， C言語
　　　コントローラユニットを動作させるための設定を行います。

　　　1) C 言語コントローラユニットを初期化する (P.19)
　　　　　　設定を行う前に，標準 RAMを使用可能な状態にします。
　　　2) パラメータを設定する (P.21)
　　　　　　C言語コントローラユニットに，パラメータを設定します。

〈4〉プログラミングする前に知っておきたいこと (P.24)
　　　バスインタフェース関数についての説明です。

〈5〉プログラミングする (P.27)
　　　CW Workbench を使って，プログラムを作成します。

　　　1) プロジェクトを作成する (P.30)
　　　　　　CW Workbench を起動し，プロジェクトの作成と設定を行います。
　　　2) ユーザプログラムを作成する (P.34)
　　　　　　C言語コントローラシステムの制御を行うユーザプログラムを作成します。
　　　3) ユーザプログラムから実行モジュールを生成する (P.36)
　　　　　　作成したプログラムを，実行可能なモジュールに変換 ( ビルド ) します。
　　　4) C 言語コントローラユニットと CW Workbench を接続する (P.37)
　　　　　　デバッグを行うために，C言語コントローラユニットと CW Workbench を接続します。
　　　5) ユーザプログラムをデバッグする (P.39)
　　　　　　作成したプログラムが正しく動作するか確認します。
　　　6) 実行モジュールを登録する (P.44)
　　　　　　プログラムを稼動用にビルドし，C言語コントローラユニットに格納します。

〈6〉動作を確認する (P.46)
　　　プログラムを実行し，動作を確認します。
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〈1〉作業を行う前に 
必要な機材を準備します。

＊ 1 あらかじめ，同じパソコンに C言語コントローラ設定・モニタツール（SW4PVC-CCPU），CW 
Workbench をインストールしておいてください。

参考

C言語コントローラ設定・モニタツールのインストールについては，下記を参照してください。
SW4PVC-CCPU インストール手順書：BCN-P5924

CW Workbench のインストールについては，下記を参照してください。
CW Workbench オペレーティングマニュアル：SH-080981

QY40P
0 1 2 3 4 5 6 7
8 9 A B C D E F

0

1

2

3

4

5

6

7

8

9

A

B

C

D

E

F

COM

24VDC
0 . 1A

12VDC

⑤Ethernetケーブル

①C言語コントローラ
　システム

②パソコン ③C言語コントローラ
    設定・モニタツール
    (SW4PVC-CCPU)

④CW Workbench

Windows  パソコン
インストール*1

インストール*1

各ユニットについては
次ページにて説明

ストレートケーブルでも
クロスケーブルでも可
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〈2〉システムを構築する

1) システム構成例
本クイックスタートガイドでは，下記のシステム構成を例に挙げて説明します。

＊電源ユニットへの配線は省略しています。

No. 名称 形名 説明

① ベースユニット Q33B
電源ユニット，C言語コントローラ
ユニット，入出力ユニットなどを
装着するユニットです。

② 電源ユニット Q62P
C 言語コントローラユニット，入出
力ユニットなど各ユニットに電気
を供給するユニットです。

③ C言語コントローラユニット Q12DCCPU-V C 言語コントローラシステムの制御
を統括するユニットです。

④ 出力ユニット QY40P －

⑤
接続ケーブル
(Ethernet ケーブル )

10BASE-T/100BASE-TX の規格を満
たす Ethernet ケーブル

SW4PVC-CCPU，CW Workbench を
インストールしたパソコンと C言
語コントローラユニットを接続し
ます。

QY40P
0 1 2 3 4 5 6 7
8 9 A B C D E F

0

1

2

3

4

5

6

7

8

9

A

B

C

D

E

F

COM

24VDC
0 . 1A

12VDC

ランプ（出力）C言語コントローラシステム

①
④

②

③

⑤
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2) ユニットを装着する
準備したユニットをベースユニットに取り付けます。

C言語コントローラユニットを初めて使用する場合は，バッテリコネクタの装着が必要です。

●バッテリは，必ず装着して運転を行ってください。

●ユニットを取り付けるときは，必ず電源を遮断してください。

Point

●C言語コントローラユニットへのバッテリの装着方法

参考

ユニットの取り外し方については，下記マニュアルを参照してください。
QCPUユーザーズマニュアル ( ハードウェア設計・保守点検編 )：SH-080472

①C言語コントローラユニット
　底部のカバーを開ける

②バッテリ側コネクタを
　C言語コントローラ
　ユニット側コネクタに，
　方向を確認して挿し込む

③C言語コントローラユニット
　底部のカバーを閉じる

完了

C言語コントローラ
ユニット側
コネクタ

バッテリ側
コネクタ

バッテリ②

C言語コントローラ
ユニット底部

③

①

ベースユニット
ユニット

側面図

側面図

ユニット
固定用突起

ユニット
固定用突起

ベース
ユニット

ユニット
固定穴

①ユニット固定用突起を
　ベースユニットのユニット
　固定穴に挿し込む

②ユニット固定穴を支点に，
　矢印方向に押して，カチッ
　と音がするまで挿し込む

完了

ユニット
ユニット
固定穴
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3) ユニットの配線を行う
電源ユニットの配線を行います。

1. 電源ユニットへの配線をする
ベースユニットへの電源線，接地線の配線例を下記に示します。

接地は，感電，誤動作を防止するために行う配線です。

2. 出力ユニットへの配線をする
出力ユニット (QY40P) への配線例を下記に示します。

ユニットの配線を行うときは，必ず電源を遮断してください。

参考

配線についての注意事項の詳細については，下記マニュアルを参照してください。
QCPU ユーザーズマニュアル ( ハードウェア設計・保守点検編 )：SH-080472

ERR

24V

24VDC
0.5A

24G

(FG)

(LG)

N

L

INPUT

～

ERR

②FG
②LG
①INPUT
100-120VAC

①電源入力端子に
　AC100Vの交流
　電源を接続

②LG,FG端子を接地

電源ユニット
(Q62P)

接地線
接地

AC100V

AC

ERR

24V

24VDC
0.5A

24G

(FG)

(LG)

N

L

INPUT

16
17
18

15
14
13
12
11
10
9
8
7
6
5
4
3
2
1

0 1 2 3 4 5 6 7
8 9 A B C D E F

QY40P

0

1

2

3

4

5

6

7

8

9

A

B

C

D

E

F

COM

24VDC
12VDC

0 . 1A

＋

ー

L

ランプ1
信号：Y00

L

ランプ2
信号：Y01
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Point

出力電源と C 言語コントローラシステム電源は，下図のように，系統を分離して配線を
行ってください。

AC100V
AC200V

主電源 中継端子台

C言語コントローラ
システム
電源 C言語

コントローラ
システム

出力機器

絶縁
トランス

制御盤内

出力電源
T1
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4) 電源が正常か確認する
システムの設置，ユニットの取付け，配線をした後に，電源が正常に入ることを確認します。

操作手順

1. 電源を入れる前の確認
・電源の配線
・電源電圧

2. C言語コントローラユニットの状態を STOPにする

3. 電源を投入

4. 電源が正常であるかを確認

C 言語コントローラユニット前面のカバーを開き，
「RUN/STOP/MODE」スイッチを「STOP」の位置に
します。

各ユニットの前面 LED を確認します。
正常な状態のときの LED 表示を下記に示します。
　① 電源ユニット：「POWER」LEDが緑色点灯
　② C 言語コントローラユニット

：「MODE」LED が緑色点灯

C 言語コントローラユニットが出荷時の状態の場合
( 標準 RAMが初期化されていない状態 )，7 セグメン
ト LED に "01" が点滅表示されますが，この段階では
問題ありません。
ユニットの初期化を行うと消灯します。

「〈3〉ユニットの設定をする」(P.19)

以上で，システムの構築が完了しました。

Point

電源を投入しても電源ユニットの「POWER」LED が消灯している場合は，電源の配線，装着
が正しく行われているか確認してください。

MODE STOP

RUN

RES.

SEL.

「RUN/STOP/MODE」スイッチ

① ②
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参考

「ERR.」LED が点灯／点滅した場合は，下記マニュアルを参照してトラブルシューティングし
てください。

C言語コントローラユニットユーザーズマニュアル ( ハードウェア設計・機能解説編 )
：SH-080764
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〈3〉ユニットの設定をする
C 言語コントローラユニットを動作させるための設定を行います。

1) C 言語コントローラユニットを初期化する
設定を行う前に，C言語コントローラユニットの標準 RAMを使用可能な状態にします。

操作手順
① ユニット前面のカバーを開け，「RESET/SELECT」ス
イッチを「RESET」側に倒します。

②「MODE」LED が消灯していることを確認してくだ
さい。

③「RUN/STOP/MODE」スイッチを「MODE」側に保
持し，「RESET/SELECT」スイッチを中央に戻します。

④「MODE」LED が " 橙色 " に点灯し，7 セグメント
LED が "00" を表示していることを確認してくださ
い。

⑤「RUN/STOP/MODE」スイッチから手を離します。
スイッチが「STOP」位置に戻ります。

⑥ 7セグメント LEDに "12"( ユニット初期化設定（機
能拡張モード )）が表示されるまで，「RESET/
SELECT」スイッチを「SELECT」側に繰り返し倒し
ます。

ユニットを初期化すると，標準 RAM内の全ファイルが消去されます。

MODE STOP

RUN

RES.

SEL.

「RESET/SELECT」スイッチ
「RESET」側に倒します。

RUN : 消灯
MODE: 消灯
USER: 消灯

MODE STOP

RUN

RES.

SEL.

「RESET/SELECT」スイッチ

中央に戻します。

「MODE」側に保持します。
「RUN/STOP/MODE」スイッチ

RUN : 消灯
MODE: 橙色 点灯
USER: 消灯

MODE STOP

RUN

RES.

SEL.

「RESET/SELECT」スイッチ
「SELECT」側に繰り返し倒します。

RUN : 消灯
MODE: 橙色 点灯
USER: 消灯
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⑦「RUN/STOP/MODE」スイッチを「RUN」側に倒し，
ユニット初期化を実行します。実行中は「RUN」
LED が点滅します。

⑧「RUN」LED の消灯および，7セグメント LED の値
が "00" になったことを確認後，C 言語コントロー
ラユニットをリセットしてください。

⑨ C言語コントローラユニットをリセットすると，標
準 RAMのフォーマットが実行されます。
「RUN」LED と「USER」LED が緑色点滅します。

⑩ 標準 RAM のフォーマットが完了すると，「RUN」
LED，「USER」LED の点滅が終了し，「MODE」LED
が橙色点滅します。

⑪ C 言語コントローラユニットをリセットしてくだ
さい。
標準 RAM のフォーマットが正常完了した場合は，
「RUN」LED  が緑色点灯，「MODE」LED が橙色点
灯します。

Point

リセットの操作手順

MODE STOP

RUN

RES.

SEL.

「RUN」側に倒します。
「RUN/STOP/MODE」スイッチ

RUN : 緑色 点滅
MODE: 橙色 点灯
USER: 消灯

RUN : 消灯
MODE: 橙色 点灯
USER: 消灯

MODE STOP

RUN

RES.

SEL.

MODE STOP

RUN

RES.

SEL.

「RESET/SELECT」スイッチ

「RESET/SELECT」スイッチ

MODE: 消灯

① C言語コントローラユニット前面の「RESET/SELECT」スイッチを，
　「RESET」側に倒します。

②「MODE」LEDが消灯したことを確認します。
[リセット完了の状態]

③「RESET/SELECT」スイッチを中央位置に戻します。

RUN : 緑色 点滅
MODE: 橙色 点灯
USER: 緑色 点滅

RUN : 消灯
MODE: 橙色 点滅
USER: 消灯

RUN : 緑色 点灯
MODE: 橙色 点灯
USER: 消灯

スイッチを操作する際に，ドライバなど先のとがった道具を使用しないでください。
破損する恐れがあります。
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2) パラメータを設定する
C言語コントローラユニットに，パラメータを設定します。

1. C言語コントローラユニットとパソコンを接続する
C 言語コントローラユニットの CH1 とパソコンを，Ethernet ケーブルで接続します。

用語

パラメータ ：C 言語コントローラシステムを動作させるために必要な設定情報のことです。
C言語コントローラ設定・モニタツールを使って，C言語コントローラシステ
ム内の各ユニットおよびネットワークの設定を行います。

接続の際には，C言語コントローラユニットとパソコンの IP アドレスを，同一セグメントに
設定する必要があります。本クイックスタートガイドでは，C 言語コントローラユニットの
IP アドレスは初期値 (192.168.3.3) を使用するため，パソコン側の IP アドレスを "192.168.3.
＊ ( ＊：0, 3, 255 以外 )" に設定してください。
また，パソコンのサブネットマスクを "255.255.255.0" に設定してください。

参考

IP アドレスの変更については，下記を参照してください。
C言語コントローラユニットユーザーズマニュアル ( ハードウェア設計・機能解説編 )：
SH-080764
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2. パソコンでパラメータを作成する
操作手順
① C言語コントローラ設定・モニタツールを起動
[スタート ]→ [ すべてのプログラム ]→ [MELSEC]
→[C言語コントローラ Ver.4]→ [C言語コントロー
ラ設定・モニタルーツ ] を選択します。

② プロジェクトの新規作成
[ プロジェクト ] → [ プロジェクトの新規作成 ] を
選択します。
CPUタイプは「Q12DC-V」を選択します。

③ CCPU パラメータの設定
プロジェクトビュー→ " パラメータ " → "CCPU パ
ラメータ "→「I/O 割付設定」タブを選択します。

参考

各設定画面および設定項目の内容は，下記を参照
してください。

C言語コントローラ設定・モニタツー
ル Version 4 オペレーティングマニュ
アル：SH-081076
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3. C言語コントローラにパラメータを書き込む
操作手順
① 接続先の設定
ナビゲーションウィンドウ→接続先ビュー→ " 現
在の接続先"→"Connection1"をダブルクリックし
ます。

下記のとおり設定します。
パソコン側 I/F：Ethernet ボード
シーケンサ側 I/F：CPU ユニット
他局指定：他局指定無し

② パラメータの書込み
[ オンライン ] → [CCPU書込 ] を選択します。

③ パラメータを全選択し， ボタンをクリッ
ク

4. C言語コントローラシステムをリセットする
書き込んだパラメータが反映されます。

Point

アカウント入力画面が表示された場合は，下記を
入力してください。
ユーザ名：target
パスワード：password
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〈4〉プログラミングする前に知っておきたいこと
1. バスインタフェース関数とは

バスインタフェース関数は，C言語コントローラユニットの専用ライブラリ関数の一つです。バスイ
ンタフェース関数をユーザプログラムに使用すれば，MELSEC-Q シリーズの各ユニットを簡単に制御
することができます。

　　(1) バスのオープン／クローズ
バスインタフェース関数を使用する場合は，プログラムの開始時にバスをオープンし，プログラムの
終了時にバスをクローズします。

バスのオープン／クローズ関数

　　(2) 入出力アクセス
入出力アクセスには，1点単位でのアクセスとワード単位でのアクセスがあります。

① 1 点アクセス：1点分の情報 ( スイッチの ON/OFF，ランプの点灯／消灯など ) を扱う関数

1点アクセス関数の具体例

② ワード単位アクセス：ワード (16 ビット ) 単位分の情報 ( 数値，文字列など ) を扱う関数

ワード単位アクセス関数の具体例

　　(3) ユーザ LED制御
ユーザ LED 制御には，C言語コントローラユニット前面のUSER LED 制御と 7セグメント LED 制御が
あります。

ユーザ LED 制御関数の具体例

関数名 機能
QBF_Open バスオープン
QBF_Close バスクローズ

Point

バスのオープン／クローズ (QBF_Open/QBF_Close) 処理は，プログラムの最初と最後の 1回
のみ行ってください。
プログラムの最初と最後の 1回にすることで，通信性能を向上させることができます。

関数名 機能
QBF_X_In_BitEx 入力信号 (X) を 1 点読み出す。
QBF_Y_Out_BitEx 出力信号 (Y) を 1 点出力する。
QBF_Y_In_Bit_Ex 出力信号 (Y) を 1 点読み出す。

関数名 機能
QBF_X_In_WordEx 入力信号 (X) をワード単位で読み出す。
QBF_Y_Out_WordEx 出力信号 (Y) をワード単位で出力する。
QBF_Y_In_WordEx 出力信号 (Y) をワード単位で読み出す。

関数名 機能
QBF_ControlLED C 言語コントローラユニットのUSER LED を制御する。
QBF_Control7SegLED C 言語コントローラユニットの 7セグメント LED を制御する。
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2. 今回使用するバスインタフェース関数
今回作成するプログラムには，出力アクセスと 7セグメント LED 制御の基本的なバスインタフェース
関数を使います。

　・バスオープン／クローズ：QBF_Open/QBF_Close 関数

　・出力アクセス：QBF_Y_Out_WordEx 関数

　・7セグメント LED 制御：QBF_Control7SegLED 関数

参考

ここでは，最も基本的なバスインタフェース関数を紹介しています。
上記のほかにも，各ユニットの制御を行うための便利なバスインタフェース関数や MELSEC
通信関数があります。

SW□ PVC-CCPU のバスインタフェース関数HELP，MELSEC 通信関数HELP
バスインタフェース関数HELP，MELSEC 通信関数HELP は，下記からダウンロードでき
ます。
三菱電機 FAサイトホームページ
(www.MitsubishiElectric.co.jp/fa)
C 言語コントローラユニットユーザーズマニュアル ( ユーティリティ操作・プログラミン
グ編 )：SH-080765
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参考

C 言語コントローラユニットで使用する C 言語および C++ 言語プログラムのデータ型には，
主に下記のようなものがあります。

データ型 ビット幅 呼称
byte 8 符号なし整数型
char 8 文字型
unsigned char 8 符号なし文字型
short 16 符号付き短長整数型
unsigned short 16 符号なし短長整数型
int 32

符号付き ( 倍長 ) 整数型
long 32
unsigned long 32 符号なし ( 倍長 ) 整数型
float 32 単精度実数型
double 64 倍精度実数型
void - -
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〈5〉プログラミングする
出力ユニットに接続したランプと C言語コントローラユニット前面の 7セグメント LED を点滅させ
るプログラムを作成してみましょう。

1. 今回作成するプログラムと制御内容
今回作成するプログラムでは，下記の制御を行います。

C言語コントローラユニットを RUNすると，出力ランプ Y00，Y01 が交互に点灯を繰り返します。
また，出力ランプの点灯に同期して，C言語コントローラユニット前面の 7セグメント LED の一位と
十位が交互に全点灯を繰り返します。
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7セグメントLED制御

/* 出力制御、7セグメントLED制御処理を20回ループ
for(i = 0; i < 20; i++){
    /* 出力制御
    sRet = QBF_Y_Out_WordEx(lPath, NORMAL_ACCESS, UNIT_XY, WORD, &usDataBuf, DUMMY);
    if(sRet != 0){
            printf("ERROR : QBF_Y_Out_WordEx_1 [%d(%04hxH)]\n", sRet, sRet);
            QBF_Close(lPath);
            return;
    /* 7セグメントLED制御
    sRet = QBF_Control7SegLED(lPath, MODE_MANUAL, &pcdata[0]);
    if(sRet != 0){

交互に　　点灯
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2. ソースコード
ソースコードを下記に示します。

ライブラリ関数などが
使えるように，関数一
覧を定義したファイル
を宣言します。

今回制御するための，
各値を定義します。

/*********************************************************************************************/
/* 関数ヘッダ                                                                                                         　                                   */
/*********************************************************************************************/
#include <vxworks.h>  /* VxWorks関数ヘッダ              */
#include <taskLib.h>  /* VxWorks関数ヘッダ                              */
#include <stdio.h>    /* 標準関数ヘッダ                       */
#include "QbfFunc.h"  /* バスインタフェース関数ヘッダ                 */

/*********************************************************************************************/
/* 定義                                                                                   */
/*********************************************************************************************/
/* デバッグ用                                                                       */
#define UNIT_XY                          0x0000       /* ユニットの先頭入出力番号                  */
#define QY_LED       0x5555    /* Y信号の初期出力値（偶数ビット点灯）     */
#define SEG_LED1     0xFF    /* 7セグメントLED出力初期値（一位）         */
#define SEG_LED2     0x00    /* 7セグメントLED出力初期値（十位）         */

/*********************************************************************************************/
/* QBF関数用                                                                        */
#define CPU_TYPE                      2                 /* CPU識別フラグ（CCPU：2）               */
#define WORD                             1                 /* ワード単位指定                    */
#define NORMAL_ACCESS       0                 /* 通常アクセス指定                    */
#define DUMMY                          0                 /* ダミー                             */
#define MODE_MANUAL          0            /* 7セグメントLED制御モード               */

/*********************************************************************************************/
/* Y出力、7セグメントLED制御処理                          */
/*********************************************************************************************/
void Q12_SampleTask()
{
    /* ローカル変数の宣言                                             */
    short            sRet;                 /* QBF関数の戻り値                 */
    long             lPath;                /* バスのパス                            */
    unsigned short   usDataBuf;            /* Y信号（ワード単位）                      */
    unsigned short   usEmptyDataBuf;       /* Y信号リセット用                           */
    char       pcdata[2];     /* 7セグメントLED点灯値             */
    short            i;                    /* ループ用                                */

    /* バスをオープンする                                            */
    sRet = QBF_Open(CPU_TYPE, &lPath);
    if(sRet != 0){
        printf("ERROR : QBF_Open [%d(%04hxH)]\n", sRet, sRet);
        return;
    }

    /* Y信号の出力値をセット（偶数ビットを点灯）                    */
    usDataBuf = QY_LED;

    /* 7セグメントLEDの出力値をセット（一位のみ全灯）                   */
    pcdata[0] = SEG_LED1;
    pcdata[1] = SEG_LED2;
 
    /* 出力制御、7セグメントLED制御処理を20回ループ                   */
    for(i = 0; i < 20; i++){
        /* 出力制御                               */
        sRet = QBF_Y_Out_WordEx(lPath, NORMAL_ACCESS, UNIT_XY, WORD, &usDataBuf, DUMMY);
        if(sRet != 0){
            printf("ERROR : QBF_Y_Out_WordEx_1 [%d(%04hxH)]\n", sRet, sRet);
            QBF_Close(lPath);
            return;
        }

        /* 7セグメントLED制御                            */
        sRet = QBF_Control7SegLED(lPath, MODE_MANUAL, &pcdata[0]);
        if(sRet != 0){
            printf("ERROR : QBF_Control7SegLED_1 [%d(%04hxH)]\n", sRet, sRet);
            QBF_Close(lPath);
            return;
        }

        /* Y信号の出力値を反転する（奇数ビット→偶数ビット→...を点灯）             */
        usDataBuf = ~usDataBuf;

バスインタフェース関
数を使い，出力ユニッ
トの制御を行います。

バスインタフェース関
数を使い，C言語コン
トローラユニット前面
の7セグメントLEDの制
御を行います。

プログラムの最初で，
バスインタフェース関
数を使える状態にしま
す。
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        /* 7セグメントLEDの出力値を反転する（一位全灯→十位全灯→...）              */
        pcdata[0] = ~pcdata[0];
        pcdata[1] = ~pcdata[1];
  
        /* ウェイト                             */
        taskDelay(40);
    }
    /* Y信号をリセットする                             */
    usEmptyDataBuf = 0x00;
    sRet = QBF_Y_Out_WordEx(lPath, NORMAL_ACCESS, UNIT_XY, WORD,
         &usEmptyDataBuf, DUMMY);
    if(sRet != 0){
        printf("ERROR : QBF_Y_Out_WordEx_2 [%d(%04hxH)]\n", sRet, sRet);
        QBF_Close(lPath);
        return;
    }

    /* 7セグメントLEDをリセットする                         */
    pcdata[0] = 0x00;
    pcdata[1] = 0x00;
    sRet = QBF_Control7SegLED(lPath, MODE_MANUAL, &pcdata[0]);
    if(sRet != 0){
        printf("ERROR : QBF_Control7SegLED_2 [%d(%04hxH)]\n", sRet, sRet);
        QBF_Close(lPath);
        return;
    }
    
    /* バスをクローズする                             */
    QBF_Close(lPath);
    return;
}

プログラムの最後で，
バスインタフェース関
数を使えない状態にし
ます。

出力ユニットの出力お
よびC言語コントロー
ラユニット前面の7セ
グメントLEDの表示を，
すべてOFFします。
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1) プロジェクトを作成する

1. CW Workbench を起動する
操作手順
① [スタート]→[すべてのプログラム]→[Wind River]
→ [CW Workbench] → [CW Workbench] を選択

② 起動後，ワークスペースの保存先フォルダを入力
します。
ここでは，"C:￥WindRiver￥workspace" とします。

③ ボタンをクリック

④ ボタンをクリック

CW Workbench のメイン画面が表示されます。

①

③

②

④

参考

・ CW Workbench の初期状態の各ウィンドウの
大きさやアイコンなどの配置は，お使いのパソ
コンによって変わります。本クイックスタート
ガイドに記載している画面と違う場合は，各
ウィンドウの大きさを調整してください。

・拡大したり消したりした各ウィンドウを初期
状態に戻すには，メニュー [Window]
→ [New Window] を選択してください。
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2. 新規プロジェクトを作成する
操作手順
① メニュー[File] → [New] → [Wind River Workbench
Project...] を選択

②「Wind River VxWorks6.4」を選択

③ ボタンをクリック

④「Downloadable Kernel Module」を選択

⑤ ボタンをクリック

⑥ プロジェクト名を入力
ここでは，"Q12_SampleProject" とします。

⑦ ボタンをクリック

これで，プロジェクト作成が完了しました。

①

③

②

④

⑤

⑥

⑦
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3. プロジェクトのプロパティを設定する
作成したプロジェクトを，C言語コントローラユニットで実行可能なモジュールに変換 ( ビルド ) す
るための設定を行います。

(1) 使用するプロセッサを設定
① Project Explorer ウィンドウから作成したプロジェ
クトを選択し，メニュー[Project] → [Properties] を
クリック

② 画面左側のツリーから「Build Properties」を選択

③「Build Support and Specs」タブをクリック

④「Available and enabled build specs」で
「SH7750gnule」のみをチェック

⑤「Debug mode」をチェック

(2) インクルードファイルを設定
①「Build Paths」タブをクリック

② ボタンをクリック

③ ボタンをクリック

用語

ビルド：プロセッサに応じたソースコードのコンパイル，インクルードファイルとのリンク
を行います。

Point

正式なシステム運用，稼動時は，「Debug mode」
のチェックをはずしてください。

①

② ③

⑤

④

②

①

③
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④「Select directory」画面から C言語コントローラユ
ニット専用のインクルードフォルダを選択
ここでは C 言語コントローラ設定・モニタツール
を"C:￥MELSEC"へインストールした場合のフォル
ダになります。

⑤ ボタンをクリック

⑥「Select directory」画面で選択したフォルダが指定
されていることを確認

⑦ ボタンをクリック

⑧「Include paths」で追加したインクルードパスが表
示されていることを確認

⑨ ボタンをクリック

⑩ ボタンをクリック後，下記のメッセー
ジが表示された場合は， ボタンをク
リック

これで，プロジェクトのプロパティ設定が完了し
ました。

④

⑤

⑥

⑦

⑧

⑨

⑩
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2) ユーザプログラムを作成する
C言語コントローラシステムの制御を行うユーザプログラムを作成しましょう。

下記 1. で示すユーザプログラムの作成は，本クイックスタートガイド専用のサンプルプログラムを使
用することで省略できます。サンプルプログラムを使用する場合は，2. から始めてください。

1. ユーザプログラムを作成する
操作手順
① Project Explorer ウィンドウから作成したプロジェ
クトを選択して右クリックし，メニュー [New] →
[File] をクリック

②「File Name」に新規作成するソースファイル名を
入力
ここでは "Q12_Sample.c" と入力します。

③ ボタンをクリック

④ Editor ウィンドウで，出力ユニットへのアクセス
および 7セグメント LED 制御するための「ソース
コード」(P.28) を記述します。

ソースコードの記述が終了したら「3) ユーザプロ
グラムから実行モジュールを生成する」(P.36)
へ移ってください。

参考

本クイックスタートガイド専用のサンプルプログラムは，下記を参照してください。
三菱電機 FAサイトホームページ
(www.MitsubishiElectric.co.jp/fa)

・C 言語コントローラユニット クイックスタートガイド

Point

ファイル名は拡張子まで入力してください。
またファイル名に全角文字は使用できません。使
用すると，コンパイル時にコンパイルエラーが発
生します。

①

②

③
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2.  サンプルプログラムを追加する
操作手順
① 今回作成したプロジェクトフォルダ直下に，本ク
イックスタートガイド専用のサンプルプログラム
を格納します。
"C:￥WindRiver￥workspace￥Q12_SampleProject"

② Project Explorer ウィンドウから作成したプロジェ
クトを選択して右クリックし，メニュー [Refresh]
をクリック

③ 手順①で格納したサンプルプログラムがプロジェ
クトに追加されます。

これで，サンプルプログラムの追加が完了しまし
た。

②

③
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 3) ユーザプログラムから実行モジュールを生成する
作成したプログラムを，C言語コントローラユニットで実行可能なモジュールに変換 ( ビルド ) しま
す。

操作手順
① Project Explorer ウィンドウから作成したプロジェ
クトを選択して右クリックし，メニュー [Rebuild
Project] をクリック

② メニュー [Rebuild Project] をクリック後，下記の
メッセージが表示された場合は， ボ
タンをクリック

プロジェクトのビルドが開始され，Build Console
ウィンドウにビルドの処理過程が表示されます。

③ Build Console ウィンドウで，"Build Finished..." が
表示されることを確認してください。

"Build Finished..." が表示されると，ユーザプログ
ラムの作成およびビルドは完了です。

①

②

③

Point

"Build Finished..."が表示されずエラーが発生した
場合は，エラー内容を確認してプログラムを修正
してください。
プログラムを修正後，再度「3) ユーザプログラム
から実行モジュールを生成する」(P.36) から実施
してください。
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4) C 言語コントローラユニットと CW Workbench を接続する
CW Workbench でデバッグを行うために，C言語コントローラユニットと CW Workbench を接続し
ます。

本手順の前に，あらかじめ 47 ページの手順 1を実行して，ユーザプログラムからの出力（Y）を許可
にしておいてください。

操作手順
① C 言語コントローラユニットから VxWorks イメー
ジファイルを取得するために，エクスプローラを
起動し，アドレス欄に下記の形式で入力します。
ftp://192.168.3.3/SYSTEMROM/OS_IMAGEFILE/

「ログイン」画面が表示されます。

②「ログイン」画面で下記のユーザ名とパスワードを
入力
・ユーザ名　　：target
・パスワード　：password

③  ボタンをクリック

④ C言語コントローラユニットに格納されている
VxWorks イメージファイルを，「C:￥MELSEC￥
CCPU4￥CCPUTool」へコピーします。

⑤ Remote Systems ウィンドウ内の  をクリック

「New Connection」画面が表示されます。

⑥「New Connection」画面にて「Wind River VxWorks
6.x Target Server Connection」を選択

⑦ ボタンをクリック

Point

C言語コントローラユニットとパソコンで通信す
る場合は，双方で同じ VxWorks イメージファイ
ルを指定する必要があります。

①

②

③

④

Point

「C:￥MELSEC￥CCPU4￥CCPUTool」は，C 言語
コントローラ設定・モニタツールを「C:￥
MELSEC」にインストールした場合に作成される
フォルダです。

⑤

⑥

⑦
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⑧「Backend settings」の設定項目で，下記の内容を
設定
・Backend ：wdbrpc
・Processor ：SH7780( ボタンをク

　　　　　　　　　リックし，ツリーから選択 )
・IP Address ：192.168.3.3( デフォルト )
・Port ：空欄

⑨「Kernel image」で「File」を選択

⑩ ボタンをクリック

「Open File」画面が表示されます。

⑪ 手順④でコピーした VxWorks イメージファイルを
ツリーから選択 (C:￥MELSEC￥CCPU4￥
CCPUTool) し， ボタンをクリック

⑫ ボタンをクリック

⑬ Remote Systemsウィンドウで追加したターゲット
サーバを選択し， をクリック

⑭ をクリック後，Remote Systems ウィンドウの
下部に "connected - target server running" が表示
されると接続完了です。

⑧

⑨
⑩

⑪

Point

"connected - target server running"が表示されな
い場合は，C言語コントローラユニットの電源が
正常に投入されていることを確認し，再度「「4)
C 言語コントローラユニットと CW Workbench
を接続する」(P.37) から実施してください。

⑫

⑬

⑭
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5) ユーザプログラムをデバッグする
作成したプログラムが正しく動作するか確認します。

1.  ユーザプログラムをC言語コントローラユニットにダウンロードする
デバッグを行うために，実行モジュールを C言語コントローラユニットのメモリにダウンロードしま
す。

ダウンロードを行うと，スクリプトファイルがなくてもプログラムが実行できます。

① Project Explorer ウィンドウから作成したモジュー
ルファイル"Q12_SampleProject.out"を選択して右
クリックし，メニュー [Download VxWorks Kernel
Task] をクリック

「Download Configurations」画面が表示されます。

②「Launch Context」にて
「VxWorks6x_192.168.3.3 (Wind River 
VxWorks 6.4)」のみをチェック

③ ボタンをクリック

用語

スクリプトファイル：C 言語コントローラユニットを立上げ時に起動するユーザプログラム
のロード先，起動順序などを記述するファイルです。

①

②

③
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Point

2 回目以降の②の操作では，
「Launch Configuration Selection」画面が表示さ
れます。｢ Launch the selected launch
configuration ｣を選択し， ボタンをク
リックしてください。
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2.  ユーザプログラムをデバッグする
① Project Explorer ウィンドウから，作成したプロ
ジェクトを選択し，ツールバーの 右脇の をク
リック

② メニュー [Debug Configurations...] をクリック

「Debug Configurations」画面が表示されます。

③「VxWorks Kernel Task」からダウンロードしたモ
ジュール "Q12_SampleProject.out" をクリック

④ C 言語コントローラユニットとの接続を示すター
ゲットサーバをチェック

⑤ ボタンをクリック

「Entry Points」画面が表示されます。

⑥ デバッグを開始する関数(Q12_SampleTask)を選択

⑦ ボタンをクリック

⑧「Entry Point」に手順⑥で選択した関数名が設定さ
れていることを確認

⑨ ボタンをクリック

⑩ デバッグが開始され，「Entry Point」で指定した関
数の先頭でプログラムの実行が止まります。

②

①

③

④

⑤

⑥

⑦

⑧

⑨

⑩
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⑪ Debug ウィンドウの で，1 ステップごとにデ
バッグを行います。

⑫ 画面右下の「Variables」ウィンドウ *1 のタブをク
リックし，各変数の値の確認や変更を行うことが
できます。
ここでは "QBF_Open" 関数の戻り値である "sRet"
が 0( 正常値 ) であることを確認します。

＊ 1　お使いのパソコンによっては，「Variables」ウィ
ンドウが下記のように表示される場合がありま
すので，ウィンドウの大きさを調節してくださ
い。

手順⑪⑫で，作成したプログラム全体をデバッグ
します。

＜ Breakpoint を使用したデバッグ方法＞

左記⑪の 1 ステップごとのデバッグではなく，プ
ログラム内の任意の位置に Breakpoint を指定して
デバッグを進めることができます。

① ソースファイルの左端をダブルクリックし，
Breakpoint 挿入します。

②  をクリック

指定した Breakpoint の位置までプログラムが実行
されます。

参考

バスインタフェース関数の戻り値が0以外の場合
は，下記を参照してトラブルシューティングして
ください。

SW□ PVC-CCPU のバスインタフェー
ス関数HELP

C 言語コントローラユニットユーザー
ズマニュアル ( ハードウェア設計・機
能解説編 )：SH-080764

⑪

⑫

①

②
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⑬ Debug ウィンドウの をクリックし，デバッグ
を終了します。

参考

各アイコンの内容は下記のとおりです。
：1ステップ実行
1 ステップ単位で実行し，関数の場合は
当該関数の中に入りステップ実行を続け
ます。

：1関数単位実行
1 ステップ単位で実行し，関数の場合は
当該関数へは入らず関数単位でステップ
の実行を続けます。

：関数の最後 (Return) まで実行します。
：プログラム実行
：プログラム停止
：デバッグ終了

Point

再度デバッグを開始する場合は，ツールバーの
右脇の をクリックし，表示されたポップ

アップメニュー上部にある生成済みデバッグ構
成を選択することでデバッグを開始できます。
上記の手順①～⑩を省くことができます。

⑬
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6) 実行モジュールを登録する
作成したプログラムを稼動用にビルドし，C言語コントローラユニットに格納します。

操作手順

1. ユーザプログラムをビルドする
① Project Explorer ウィンドウから作成したプロジェ
クトを選択し，メニュー[Project] → [Properties] を
クリック

② 画面左側のツリーから「Build Properties」を選択

③「Debug mode」のチェックをはずす。

④ ボタンをクリック

⑤「3)ユーザプログラムから実行モジュールを生成す
る」(P.36) に従ってビルドします。

⑥ 下 記 の メ ッ セ ージ が表 示 され た場 合は，
ボタンをクリックしてください。

2.  ユーザプログラムを格納する
① エクスプローラを起動し，C 言語コントローラ
ユニットのアドレス欄を，下記の形式で入力し
ます。
ftp://192.168.3.3/ROM

C言語コントローラユニットへログインすると，下
記のように表示されます。

② 作成したユーザプログラム "Q12_SampleProject.
out" をドラッグ＆ドロップで C 言語コントローラ
ユニットの標準 ROMへコピーします。
本クイックスタートガイドで作成したユーザプロ
グラムは，下記に格納されます。
C: ￥WindRiver ￥workspace ￥Q12_SampleProject ￥
SH7750gnule￥Q12_SampleProject￥NonDebug

①

④

③

②

⑥

①

②
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3.  スクリプトファイルを作成・格納す
る
C 言語コントローラユニットを起動時に，実行モ
ジュールを自動的にロードするためのスクリプト
ファイルを作成します。

① テキストファイルを開き，下記のようにユーザプ
ログラムのロード，タスク生成を行うスクリプト
ファイルを記述します。

② ファイル名を "STARTUP.CMD" として保存します。

③ 作成したスクリプトファイルを，C言語コントロー
ラユニットの標準 ROMへコピーします。
ftp://192.168.3.3/ROM

これでスクリプトファイルの作成・格納は完了で
す。

参考

今回のスクリプトファイルは，下記からダウン
ロードできます。

三菱電機 FAサイトホームページ
(www.MitsubishiElectric.co.jp/fa)

・C 言語コントローラユニット クイッ
クスタートガイド

“Q12_SampleProject.out”
ファイルを標準ROMから

ロードします。
“Q12_SampleTask”関数を
デフォルトタスク名(t1)
で生成します。

③

Point

ユーザプログラム，スクリプトファイルは標準
ROM 以外に，コンパクトフラッシュカードにも
格納することができます。
スクリプトファイルを両方に格納した場合は，コ
ンパクトフラッシュカード内のスクリプトファ
イルが優先的に起動します。
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〈6〉動作を確認する
C 言語コントローラユニットへ登録したプログラムを実行し，動作を確認します。
操作には C言語コントローラユニット前面の「RUN/STOP/MODE」スイッチと「RESET/SELECT」ス
イッチを使用します。
［RUN/STOP/MODE スイッチの用途］
 ・RUN ：ユーザプログラムからの出力 (Y)，バッファメモリ書込みを許可
 ・STOP ：ユーザプログラムからの出力 (Y)，バッファメモリ書込みを禁止
 ・MODE ：ハードウェア自己診断機能などで使用

［RESET/SELECT スイッチの用途］
 ・RESET ：ハードウェアリセット，プログラムリセット
 ・SELECT ：ハードウェア自己診断機能などで使用

Point

C 言語コントローラユニットのプログラムの演算は，スイッチの状態が RUN/STOP にかかわ
らず実行されます。

参考

「RUN/STOP/MODE」スイッチおよび「RESET/SELECT」スイッチの詳細については，下記マ
ニュアルを参照してください。

C言語コントローラユニットユーザーズマニュアル ( ハードウェア設計・機能解説編 )
：SH-080764
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操作手順

1. ユーザプログラムからの出力 (Y) を許可

2. C言語コントローラユニットのリセットを実行

Point

「RUN/STOP/MODE」スイッチを「STOP」の位置にすると，ユーザプログラムからの出力 (Y)
は禁止されます。

参考

「ERR.」LED が点灯／点滅した場合は，下記マニュアルを参照してトラブルシューティングし
てください。

C言語コントローラユニットユーザーズマニュアル ( ハードウェア設計・機能解説編 )
：SH-080764

MODE STOP

RUN

RES.

SEL.
MODE STOP

RUN

RES.

SEL.

「RUN/STOP/MODE」スイッチ

MODE: 橙色 点灯
RUN : 消灯

MODE: 橙色 点灯
RUN : 緑色 点灯

① C言語コントローラユニット前面の「RUN/STOP/MODE」スイッチを
　「RUN」側に倒します。

②「RUN」LEDが緑色点灯すれば，正常にプログラムが実行しています。

STOP状態時のLED表示（前面カバーを閉じた状態）

RUN状態時のLED表示（前面カバーを閉じた状態）

MODE STOP

RUN

RES.

SEL.

MODE STOP

RUN

RES.

SEL.

MODE STOP

RUN

RES.

SEL.

「RESET/SELECT」スイッチ

「RESET/SELECT」スイッチ

MODE: 橙色 点灯

MODE: 消灯

① C言語コントローラユニット前面の「RESET/SELECT」スイッチを，
　「RESET」側に倒します。

②「MODE」LEDが消灯したことを確認します。

[リセット中]（前面カバーを閉じた状態）

[リセット完了の状態]（前面カバーを閉じた状態）

③「RESET/SELECT」スイッチを中央位置に戻します。
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3. 7 セグメント LED，ランプを使って，動作を確認する
C 言語コントローラユニット前面の 7セグメント LED と出力ランプが，下記のように点灯します。

① C 言語コントローラユニット前面の 7セグメント LED が，交互に 20 回，全点灯を繰り返します。

② ①に同期し，出力ランプ Y00 と Y01 が交互に点灯を繰り返します。

③ 再度，確認したい場合は，C言語コントローラユニットをリセットします。

参考

7 セグメント LED および出力ランプの状態は，C 言語コントローラ設定・モニタツールでも
確認できます。(P.49)

QY40P
0 1 2 3 4 5 6 7
8 9 A B C D E F
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よく使う機能
C 言語コントローラユニットで，システム立上げ時や運用・稼動後の保守などによく使う機能を紹介
します。

〈1〉エラーを確認して対処する
C 言語コントローラ設定・モニタツールを使って，発生したエラーの内容を確認し，対処することが
できます。

1) エラーが発生した場合の確認と対処方法

操作手順

① [診断 ] → [CCPU診断 ] を選択します。
② 画面にエラーコードが表示されます。

③ 発生したエラーに該当するエラー項目が (赤 )に
なります。
モニタ中は常に最新のエラーコードに更新されま
す。
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2) 今までに発生したエラー履歴の確認方法
今までに発生したエラーの履歴と詳細情報を確認することができます。
いつ，どのようなエラーが発生したかを知ることができ，トラブルの解析に役立ちます。

操作手順
① [ 診断 ] → [ イベント履歴 ] を選択します。

② 今までに発生したエラーの履歴と詳細情報が表示
されます。

③ 詳細を知りたいエラーの行をダブルクリックしま
す。

｢イベント詳細情報｣画面が表示されます。

④ または ボタンをク
リックすると，直前または直後のエラーの詳細情
報に切り替わります。

⑤ ボタンをクリックすると，選択してい
るエラーのヘルプが表示されます。
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〈2〉ユニット状態のモニタと動作テストを行う
C 言語コントローラ設定・モニタツールを使って，ユニットの入出力やバッファメモリの状態が確認
できます。また，立上げ時や保守時などに，一時的な入出力の確認や動作テストができます。

1) ユニットの入出力とバッファメモリの状態の確認方法
ユニットの入力 (X)，出力 (Y)，バッファメモリの状態をモニタできます。

操作手順

1. [ オンライン ]→ [ デバイスモニタ ] を選択
「デバイスモニタ」画面が表示されます。

用語

バッファメモリ ：インテリジェント機能ユニット (A/D，D/A 変換ユニットなど，入出力
以外の機能を持つユニット ) 内部の記憶領域で，C 言語コントローラ
ユニットと受け渡しするデータ ( 設定値，モニタ値など ) が格納され
ます。
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2. 「デバイスモニタ」画面の確認

No. 名称 内容

① デバイス デバイス名を入力します。

② モニタ形式

モニタ形式を指定します。
ビット&ワード：モニタ画面をビットおよびワード表示に変更します。
ビット多点：モニタ画面をビット表示のみに変更します。
ワード多点：モニタ画面をワード表示のみに変更します。

③ 表示 モニタ形式が，"ビット &ワード "または "ワード多点 " のときに，表示するデバイ
スの表示形式を指定します。

④ 数値 表示が "16 ビット整数 "または "32 ビット整数 " のときの基数 (10 進 /16 進 ) を指定
します。

⑤ ビット並び順
モニタ中のビットデバイスの並び順を指定します。
F-0：左から F，E，…，1，0の順に並びます。
0-F：左から 0，1，…，E，Fの順に並びます。

①

②

③
④

⑤
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2) 強制出力による動作テストの実施方法
出力 (Y) の強制出力を行うことで，ユニットの動作テストを実施できます。ここでは，出力 (Y) の強
制出力の手順を示します。

1. 「デバイス書き込み」画面で ボタンをクリック

2. 出力（Y）の強制出力が実行されます。

Point

バッファメモリへの強制書込みによる動作テストも，同様の手順で行うことができます。
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MEMO
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Windows は，米国Microsoft Corporation の米国およびその他の国における登録商標または商標です。
Ethernet は，富士ゼロックス株式会社の日本における登録商標です。
CompactFlash およびコンパクトフラッシュは，SanDisk Corporation の登録商標または商標です。
VxWorks は，Wind River Systems, Inc. の登録商標または商標です。
本文中における会社名，システム名，製品名などは，一般に各社の登録商標または商標です。
本文中で，商標記号 ( ™ , ®) は明記していない場合があります。






	1 ガイドの見方
	2 はじめに
	目次

	3 C言語コントローラユニットでできること
	複雑かつ高速な処理や上位サーバとの通信処理ができます
	豊富な機能を実装し，リアルタイムな制御を実現します
	C言語コントローラユニットの特長

	4 関連マニュアル
	C言語コントローラユニットについて詳しく知りたいとき
	CW Workbenchについて詳しく知りたいとき

	5 C言語コントローラユニットを使ってみよう
	〈1〉作業を行う前に
	〈2〉システムを構築する
	1)システム構成例
	2)ユニットを装着する
	3)ユニットの配線を行う
	4)電源が正常か確認する

	〈3〉ユニットの設定をする
	1) C言語コントローラユニットを初期化する
	2)パラメータを設定する

	〈4〉プログラミングする前に知っておきたいこと
	〈5〉プログラミングする
	1)プロジェクトを作成する
	2)ユーザプログラムを作成する
	3)ユーザプログラムから実行モジュールを生成する
	4) C言語コントローラユニットとCW Workbenchを接続する
	5)ユーザプログラムをデバッグする
	6)実行モジュールを登録する

	〈6〉動作を確認する

	6 よく使う機能
	〈1〉エラーを確認して対処する
	1)エラーが発生した場合の確認と対処方法
	2)今までに発生したエラー履歴の確認方法

	〈2〉ユニット状態のモニタと動作テストを行う
	1)ユニットの入出力とバッファメモリの状態の確認方法
	2)強制出力による動作テストの実施方法





